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Overview

The Device Configurator is part of a collection of tools included with the ModusToolbox software. Use the Device
Configurator to enable and configure device peripherals, such as clocks and pins, as well as standard MCU
peripherals that do not require their own tool.

Note If you make changes to Device Configurator settings, you are making changes to a standard Board Support
Package (BSP) library, which will cause the repo to become dirty. Additionally, if the BSP is in the shared asset
repository, changes will impact all applications that use the shared BSP. If you wish to make changes, you should
first copy the configuration information to the application and override the BSP configuration or create a custom
BSP. For more information, refer to the ModusToolbox User Guide.

Some complex peripherals, such as CapSense®, SegLCD, etc., have specialized configuration tools, and the
Device Configurator provides links to launch those separate tools (see Launch Other Configurators). After
configuring and saving a particular device’s settings, the Device Configurator generates firmware for use in your
application (see Code Generation).

File Edit View Help
CYSC6247BZ1D54 | CYW4343WKUEG Serial Communication Block (SCB) 1 - Parameters [=2]E3]
Peripherals | Pins  Analog-Routng = System | Perppheral-Clocks = DMA Enter filter text... &8 B
Enter filter text... ZIF B X [ [ || Neme Value =
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- )] -
B Serial Communication Block (SCB) 1 w10~ ] 2) Bit Order LIS
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Serial Communication Block (SCB) 2 scb 2 2) Data Width St
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()] -
Serial Communication Block (SCB) 4 scb_4 - Stop Bits 16t
) - (7) Enable Digital Filter
Serial Communication Block (SCB) 5 sch_5 ~ Support R5-485
Serial Communication Block (SCB) & sch_ 8 ’7\ TA-Enable
Serial Communication Block (SCB) 7 sch_7 v FICV\;—ECHUD‘
() Enable Flow Control
Serial Communication Block (SCB) 8 scb 8 r.)\ CTS Polarity e lon -
o Universal Serial Bus (USB) 0 usb_0 r.)\ RTS Polarity el -
» Digita .
- gygtim (2) RTS Activation Level 63
¥ C5D (CapSense, etc.) 0 CYBSP_CSD C5D-2.0 - C:chncnz
LCD Direct Drive 0 led_0_drive_0 U Clock “unassigned> s -
Multi-Counter Watchdog Timer (MCWDT) 0 |srss_0_mcwdt D - Serial Communication Block (SCB) 1 - Parameters Code Preview
Motice List [E1E5)
00 Errors | 0 Warnings i_:j 1Task oi Infos
* | Fixx Description Location
D The 'Clock’ parameter must not be empty. CYBCE24TBZI-D54: Serial Communication Block (SCB) 1 [Clock]
Ready

The following are the terms used in this guide that you may not be familiar with:
m  Resource - Includes peripherals, pins, clocks, etc. used in an application.
m Configurator — A GUI-based tool used to configure a resource.
m  Application — One or more projects related to each other.

m  Personality — A file that defines a resource behavior.
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m  Device Support Library — A device support library provides critical firmware and device data files to
configurators. Device support libraries are identified with a file named devicesupport.xml. It is used to find
things like other tools, devices, and personalities.

Launch the Device Configurator

You can launch the Device Configurator in various ways as described in this section; however, the tool's
configuration (design.modus) file requires an association to an application in order to obtain device configuration
information. The easiest way to do that is to launch the Device Configurator from an application within the Eclipse
IDE. If you prefer not to use the Eclipse IDE, you can launch the tool using a make command inside the
application directory.

If you launch the Device Configurator and open a configuration file without an association to an application, the
tool may open the following dialog, indicating that it cannot find the device support library:

Mo 'device support library' path provided.
C:/Users/CKF/examples_2.2/mtb_shared/ TARGET_CYBCKIT-062-WIFI-BT/latest-
v2X/COMPONENT BSP_DESIGN_MODUS/design.modus

Use the following dialog to find the device support library (devicesupportxml).
By default you'll find the device support libraries in the workspace's mtb_shared
folder, The correct device support library depends on your selected target:

PSaC 6 look for devicesupportaxml in the mtb-pdl folder.

PSoC 4: look for devicesupport.xml in the mtb-psocd-pd| folder.

BTSDK v2.8 and later: look for devicesupport.xml in the appropriate chip-specific
folder (default: mtb_shared/wiced_btsdk/dev-kit/baselib/ < chip>).

Note: Some applications may contain a private copy of the device support library
in the 'libs' subfolder.

oK

In this case, after closing the dialog, you must navigate to the appropriate directory to find the device support
library file.
From the Eclipse IDE

To launch the Device Configurator from the Eclipse IDE, right-click on the project and select ModusToolbox >
Device Configurator.

{5 Proju. 30 4% Deb.. 1 Regin. 7. Per.. = O [#) READMEmd 52
§)
~ & > Hello_World [Hello_World latest-vl ¥ re2c2201 PSoC 6 MCU: Hello World
i Archives New >
&) Includes Go Into . - }
= build strates simple UART communication by printing
Gy » deps Open in New Window D using a Timer resource using PSoC® 6 MCU
(% images ModusToolbox > Library Manager 1.2 Cirl+8
(3 libs Co CtrleC CapSense Configurator 3.10
£y main.c = D CapSense Tuner 3.10
= Paste Crlev apSense Tuner 3.
-+ LICENSE E :
2 > Makefile % Delete T Device Configurator 2.20
= makefileinit Cotiee 3 Device Firmware Update Tool 1.30
Y o DCADKAC el o 3
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You can also open the Device Configurator by clicking the link in the Eclipse IDE for ModusToolbox Quick Panel:

B Qi | =Ver.. STEx. %Br. = O

Eclipse IDE for =
ModusToolbox™

b Start

» Hello_World

b Launches

- ool

Library Manager 1.2

@& CapSense Configurater 3,10

@8l CapSense Tuner 3.10

vice Firmware Update Tool 1.30
@& Power Estimator 1.30
B QsPI Configurator 2.20
< >

This opens the Device Configurator using the application's design.modus file, which contains all the required
hardware configuration information about the device for the application. When you save updates to the
design.modus file, the tool generates/updates source code in the GeneratedSource directory next to the

design.modus file. Eclipse IDE applications use the design.modus file and generated source code in future
application builds.

From the Command Line

If you prefer not to use the Eclipse IDE, you can launch the Device Configurator from the command line. Run the
appropriate shell program that is configured to use the ModusToolbox build system. Navigate to your application
directory where the makefile is located, and type the following command:

make config

This also opens the Device Configurator using the application's design.modus file, the same as opening the tool
from the Eclipse IDE.

For more information about the ModusToolbox build system and make commands, refer to the ModusToolbox
User Guide.

As a Stand-Alone Tool

You can launch the Device Configurator as a stand-alone tool. As stated previously, if you launch it this way, you
will likely have to specify the path to the device support library. By default, the Device Configurator is installed

here:
<install_dir>/ModusToolbox/tools_<version>/device-configurator

On Windows, launch the tool from the Start menu. For other operating systems, navigate to the install location
and run the executable.

When it is run as a stand-alone tool, the Device Configurator opens without any content. You can either open a
specific *.modus file or create a new one. See Menus for more information.

m If you create a new *.modus file, specify the file name and location to store the new *modus file, and
select a part number for the application. See Create Design dialog for more information.

m If you open an existing *.modus file from a non-Eclipse IDE application, it will be your preferred working
environment flow.

m If you open a design.modus file for an Eclipse IDE application, it will be the same flow as if you opened it
from an Eclipse IDE application.
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Quick Start

This section provides a simple workflow for how to use the Device Configurator.

1. Launch the Device Configurator.

2. Enable a desired peripheral on the Peripherals Tab by clicking the enable check box. Notice the
Parameters Pane becomes populated with fields.

C:/Users/CKF/examples_2.2/HelloWaorld/Hello_World/libs/TARGET_CY8CKIT-062-WIFI-BT/COMPONENT_BSP_DESIGN_MODUS/design.modus® - Device Configurator 2.  — m] *
Eile Edit View Help

== e

CYBCE247BZI-D54 | CYWA343WKUBG 12-bit SAR ADC - Parameters @®

Peripherals | Pins | AnalogRouting | System  Perpheral-Clocks =~ DMA Enter filter text.., 213 B

Enter filter text... ZIF B £ B [ Name Value -
= Peripheral Documentation

Besource Blamets) Personality "'_.?\,' Configuration Help Open SAR Documentation

~ Analog

~ General

CowbowoiComeariond Ipcomp_0_comp_0 (7) Vref Select Intemal Reference (from AREF Resource) .
Low-Power Comparator 1 Ipcomp_0_cormp_1 Vref Voltage (V) 0.000
= | Programmable Analog 0 Mumber of Channels 2
12-bit Cantinuaus Time DAC 0 ) ctdac_0 Vref Bypass v
I 12-bit SARADC Y |sa20 -~ Vneg for Single-Ended Channels | Vssa -
AREF aref_0 i (%) Target Scan Rate (sps) 20000

CTBm[0] OpAmp 0 Achieved Free-Run Scan Rate (sps) (%)

CTEm([0] OpAmp 1

)_ctb_0_oa_0
— Achieved Scan Duration
et Dol * Connections
b Communication

» Digtal Z Clock <unassigned> =
B IET 12bit SAR ADC - Parameters | Code Freview
Motice List @®
o 0 Errors 1 0 Warnings Ej 5Tasks o 6 Infos

~ Fix  Description Location =
E The 'Clock’ parameter must not be empty. CY8C6247BZ1-D54: 12-bit SAR ADC [Clock]
D The connection list for signal "Ch0 Vplus” can't be empty CYBC6247BZ1-D54: 12-bit SAR ADC [Vplus Connection]
El The rannection list far sianal "Chl Valus" can't he emnty CNACARZATRZI-N54: 12-hit SAR ADC Wolus Connectinn] ™
Ready

3. Notice also that a new task may appear in the Notice List Pane.

See Icons for descriptions of the various icons displayed in the Device Configurator.

4. Double-click on the task to jump to the parameter that needs to be addressed.

Mame Value 3
'/'_?\, Wneg for Single-Ended Channels | Vssa -
"'_?\, Target Scan Rate (sps) 20000
Achieved Free-Run 5can Rate (sps) [
Achieved Scan Duration [
~ (Connections |
B Clock <unassigned> -
Clock Fr=
— | & Task: The 'Clock’ parameter [
-/‘_?\, EOS Trig must not be empty. pssigned:>
2 SOCEn .
~ Sampling Clock that operates this block
"'_?\, Differential Result Format Signed b
() Differential Code Range (% 0xB00 to OxTFF
(?) Differential Voltage Range (%) Vneg +/-Vref -
12-bit SAR ADC - Parameters | Code Preview

5. Select an appropriate parameter value and the task should be removed from the Notice List.
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6. Select the Code Preview Pane to see a preview of the code that will be generated upon saving.

Code Preview @
[Enter search text...

f* NOIE: This is a preview only. It combines elements of the .c and .h files. ¥/ =

#include "cy smif.h"

#include "cycfg_gspi_memslot.h”

#if defined (CY USING HAL)
#include "cyhal hwmgr.h"

#endif //defined (CY_USING HAL)

#define smif 0_HW SMIFO

#define smif 0_IRQ smif_interrupt_IROn

#define smif 0_MEMORY MODE ALIGMENT ERRCR (OUL)

#define smif_0_RX_DATA FIFO_UNDERFLOW (OUL)

$define smif 0_TX_COMMAND FIFO_OVERFLOW (0UL)

#define smif_0_TX_DATA FIFO_OVERFLOW (OUL)

$define smif_0_RX_FIFO_TRIGEER_LEVEL (0UL)

#define smif 0_TX FIFO_TRIGEER_LEVEL (OUL)

#define smif 0_DATALINESO_1 {(1lUL)

#define smif 0 DATALINES2 3 (0UL)

#define smif 0_DATALINES4_5 (OUL)

#define smif 0 DATALINESE 7 (0UL)

#define smif 0_S50 (1UL)

#define smif 0_S51 (OUL)

#define smif 0_552 (OUL) -
] »

Quad Serial Memory Interface (QSP1) 0 - Parameters | Code Preview

7. Use the various tabs to enable and configure other resources as needed in the same manner as
peripherals.

8. Save the *modus file to generate source code.

The Device Configurator generates code into a “GeneratedSource” directory in your Eclipse IDE
application, or in the same location you saved the *.modus file for non-Eclipse IDE applications. That
directory contains the necessary source (.c) and header (.h) files that use the relevant driver APIs to
configure the hardware. Application code then uses this code to configure the system.

9. Use the appropriate API in your application code.

Code Generation

The Device Configurator generates structures, defines, and initialization code for the blocks on the chip. All
generated code is located in the GeneratedSource folder next to the *.modus file. Refer to the Peripheral Driver
Library (PDL) API Reference for more information about this code. Each enabled resource has a link to the
specific driver documentation in the Parameters Pane.

Note The Device Configurator generates code based on the hardware resources that are enabled. If a resource is
not enabled, no configuration will be generated for it. This means the resource will retain its default reset state. In
most cases, this is powered off. However, some features are enabled by default, such as debug connectivity. To
disconnect these features, you must call the appropriate API functions to turn the feature off.

The defines and structures are all named based on the resource that created it. In general, these have the form
<resource-name>_config. These structures can be passed to the PDL functions that are responsible for
configuring the hardware block.

The functions are specific to a resource category and have names of the form init_cycfg_<resource-category>.
The init function for a particular resource type is located in GeneratedSource/cycfg <resource-category>.h. There
are also the cycfg.h and cycfg.c files. Include the cycfg.h file in your application to access the generated header
files. The cycfg.c file implements init_cycfg_all(), which calls all other generated functions, for example
init_cycfg_pins().

The resource types include:
m  Clocks: Peripheral clocks.
m  Connectivity: Configuration of the programmable analog and digital routing resources.
m  Peripherals: Fixed function analog and digital peripherals.
m  System: Overall configuration function to setup all power and clock options.

It is up to you to make use of the generated code based on the application's needs. This can be done as part of
the application’s main() loop.
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GUI Description

The Device Configurator GUI contains menus, icons, tabs, and several panes used to configure MCU peripherals.

Menus

File

m  New - Creates a new *.modus file. See Create Design dialog for more information. The current file, if any,
will be closed.

m  Open — Opens an existing *.modus file. The current file, if any, will be closed.
m Close — Closes the current file. If there are pending changes, you will be prompted to save the file.

m Save — Saves the current file and generates code for the related Eclipse IDE application. If there are
errors in the application, a dialog will indicate such. The file will still be saved.

m  Save As — Saves the current file with a different name and/or location.

m  Open in System Explorer — This opens your computer’s file explorer tool to the folder that contains the
*.modus file.

m  Change Library — Opens a dialog to select a different device support library (devicesupport.xml) file used
for resource Personalities.

The path to this file is usually stored relative to the *.modus file. If for any reason the device support
library cannot be found (for example, the *.modus file has been moved on disk), you will be prompted to
manually enter the path.

Note This menu option is not available if a command-line override has been used.

m  Change Devices — This opens the Change Devices dialog to select an alternate MCU device and/or
add/remove Companion devices.

m  Recent Files — Shows up to five recent files that you can open directly.
m  Update All Personalities — Use this item to update all resource Personalities.

For example, if you load a *.modus file made with an older device support library, there might be many
warnings in the Notice List Pane to update personalities or that a personality is no longer supported. Each
warning must be addressed, and doing so one at a time can be annoying. The Update All Personalities
menu item addresses them all at once.

m Exit — Closes the tool. You will be prompted to save any pending changes.

Edit
m  Undo — Undoes the last action or sequence of actions.

m  Redo — Redoes the last undone action or sequence of undone actions.

View

Contains toggles to hide or show different panes. All panes are shown by default. There is also a command to
show or hide the Toolbar (hidden by default).

Help

Opens this document and the About box.
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Ilcons

When configuring various options with this tool, you will see the following icons:

(?) Indicates there is a tooltip. Hover over the icon to display a brief message about the setting.

= Enables or disables a specific resource.

o 1 D o There may be occasions where an error, warning, task, or info icon displays for an enabled resource. See
Notice List Pane for more details.

.| When shown in Parameters, this indicates that it is a read-only field.

When shown for a Resource, this indicates the resource is locked and disabled. There is a tooltip
explaining why the resource is locked.

E When shown for a Resource, this indicates the resource is locked and enabled. There is a tooltip explaining
why the resource is locked.

& After assigning a signal, clicking this icon jumps to the linked resource(s).

Create Design Dialog

Use the Create Design dialog to create new *.modus files. You usually do this when launching the Device
Configurator without the Eclipse IDE. Open this dialog using the File > New option or pressing [Ctrl] + [N].

File name: |C i

Library: |C:'__ 5/CKF/Doa

MCU Device: [crBosa47z1 BLDS3 ~]

Enter filter text...
CYW4343WKUBG
[0 CYW4343WKWBG
[ CYW43012TCOKFFEH
[ CYwa3012WKWBG

Companion Device(g):

oK Cancel

To create a new *.modus file:

1. Click the Browse [ .. .] button next to File name, navigate to the location to save the new file, and enter
a file name.

2. Click the Browse [ .. .] button next to Library, navigate to the location of the library (devicesupport.xml)
file, and select it.

Select an MCU Device from the pull-down menu.
4. |If applicable, select one or more Companion Device(s) from the list.

Click OK to close the dialog and load the new *.modus file into the Device Configurator.
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Change Devices Dialog
Use the Change Devices dialog to select an alternate MCU device and/or add/remove Companion devices.

Note If you change devices using this dialog, it only applies only to the current design.modus file. You must also
make changes to the BSP makefile or you will encounter build errors. The best way to change devices is to create
a custom BSP. Refer to the ModusToolbox User Guide for more details.

Open this dialog from the File menu.

MCU device: CYBC6137FDI-F02 -

E ter text...
v CYWA3M3WKUBG
CYW4343WKWEG
CYW43012TCOKFFBH
CYW43012WKWEG
CYW43438KUBG
Companion devices:

oK Cancel

To select an alternate MCU device, click the pull-down menu and click on the desired device.

To add/remove Companion devices, click the check box to enable/disable the desired device(s).

Device Tabs

The Device Configurator can be used to configure multiple devices. All devices selected in the Create Design
dialog or the Change Device dialog display in top-level tabs above the Resource tabs. If there is only once
device, then no Device tabs are shown.

File View Help
CY8C6247BZI-D54 CYW4343WKLUBG

Peripherals Pins Analog-Routing System Peripheral-Clocks DMA

All the settings for each Device tab are configured separately.

Resources Tabs

For PSoC 6 MCUs, the Device Configurator contains several tabs, each of which provides access to specific
resources. For WICED Bluetooth and Wi-Fi devices, there are no separate tabs; resources are shown in a single
pane, sometimes under collapsible trees.

When you enable a resource, or select an enabled resource, the Parameters pane displays various configuration
options. As described under Icons, some enabled resources may contain errors, warnings, tasks, or infos that
indicate some action might be required to resolve the issue. See Notice List Pane for more details.

Note Only the tabs relevant for a selected device are displayed, so some of the tabs may not be included for
some devices.

m Peripherals — Options to enable any of the analog, digital, system, and communication hardware
capabilities of the chip that are not related to the platform.

m  Pins — Options for all the pin related resources.

m  Analog-Routing — This tab shows all the analog resources, whether enabled or not, and how they
connect. It also allows you to edit routes.
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m  System — Options for chip-wide configuration settings such as system clocks, power management, and
debug interfaces.

m Peripheral-Clocks — Options for all the peripheral clocks.

m  DMA - Provides configuration of the DMA channel and transaction descriptors.

Each of the tabs (except the Analog-Routing) has the following features:

m Filter — The Resource column shows all available resources in an expandable tree. The filter box above
the list of peripherals allows you to limit the peripherals shown in the tree as well as a Hide disabled
resources filter button. There are also Expand and Collapse commands.

m Cut, Copy, Paste — Use these commands to move and copy settings from one resource of the same type
to another.

O When you use Cut, the settings will be copied to the clipboard, and the selected resource will be
disabled.

When you use Copy, the settings will just be copied to the clipboard.

When you use Paste, the selected resource will be enabled if needed. The selected resource must
support the same Personality name and version as the cut/copied resource.

m  Name(s) — This displays the current resource name(s). This is an editable field where you can specify
optional, alternate names for this resource. This is also used in generated code.

Note Enter any string in this field. The tool converts the name into a legal C identifier and replaces non-
legal characters with underscores. If entering more than one name, use a coma-separated list.

m  Personality — Each resource has a “Personality” file that contains the information for the given resource.

O Some peripherals, such as Serial Communication Block (SCB) and Timer, Counter, Pulse Width
Modulator (TCPWM), have a pull-down menu to select a specific personality, such as UART, SPI, or
I2C.

Some peripherals have multiple personality versions from which you can select.

Some peripherals have a read-only field that only shows the name of this resource’s personality file.
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Peripherals

The Peripherals tab/tree is where you enable various analog, digital, system, and communication peripherals for
the device to include in your application. The filter box and the hide disabled button above the list of peripherals
allows you to limit the resources shown in the tree. This tab allows you to enter one or more Names for the
resource, and it shows the selected Personality.

PSoC 6 Applications

Peripherals Pins Analog-Routing Systzm Peripheral-Clocks DMA
Z |7 B & BB
Resource MName(s) Personality
Analog

“  Communication
D Inter-1C Sound Bus (125) 0 audioss_0_i2s_0
Quad Serial Memory Interface (Q5P) 0 CYBSP_QSPI Quad Serial Peripheral Interface (Q5PI)-1.1
D Serial Communication Block (SCE) 0 sch 0
D Serial Communication Block (SCE) 1 sch 1
Serial Communication Block (SCE) 2 CYBSP_ET_UART UART-1.0 b
Serial Communication Block (5CB) 3 CYBSP_CSD_COMM | EZI2ZC-1.0 b
D Serial Communication Block (5CE) 4 sch_4
D Serial Communication Block (5CEB) 3 sch_3
D Serial Communication Block (SCE) & sch_B
D Serial Communication Block (SCB) 7 sch_7
D Serial Communication Block (SCE) 8 sch_8
Universal Serial Bus (USB) 0 CYBSP_USBUART USBFS Device-1.1

Digital

v System
C5D (CapSense, etc) 0 CYBSP_CSD CSD-2.0
D LCD Direct Drive 0 led_0_drive_0
Multi-Counter Watchdog Timer (MCWDT) 0| CYBSP_MCWDTO Multi-counter watchdog-1.0
D Multi-Counter Watchdog Timer (MCWDT) 1 |srss_0_mowdt_1
Real Time Clock (RTC) CYBSP_RTC Real Time Clock-1.1
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Bluetooth Applications

Entel

r filte

rtext..

$EE Q]

Resource

“ Peripherals

7 apc

[ armio

Bluetooth

[ cleck

[ &cl-sec

[T

[] 12s/pcm

D Keyboard Scanner
I:‘ Low Moise/External Power Amplifiers
[ rom

O rwmo

[ pwima 1

[ pwm 2

[ Pwmaz

[ pwnt 4

[ pwwmas

I:‘ Quadrature Decoder
[ spi1

Cspz

[ swo

UART 1 (HCI UART)
UART 2 (PUART)

Pins

Mame(s)

adc 0

armio_0

ET

clock_ 0

coex 0

2.0

audio_0

keyscan_0

amplifiers_0

pdm_0

pwm_0

pwm_1

wm_2

am_3

wm_4

EREREREE

wm_3

quadrature_0

spi_0

spi_1

swd_0

UART

PUART

Personality

Bluetooth-1.0

UART-1.0
UART-1.0

Pins-1.0

P10

Pins

The Pins tab/tree is where you enable all the pin related resources. All available pins are shown in an expandable
tree, arranged by port number. The filter box and the hide disabled button above the list of pins allows you to limit

the pins shown in the tree. This tab allows you to enter one or more Names for the resource, and it shows the

selected Personality.

The interactive pin package diagram shows the different states of the pins; there is a legend on the diagram. You
can enable/disable a pin by double-clicking it in the diagram. There are also zoom commands to resize the
diagram as needed. If you zoom the image larger than the frame area, scroll bars appear to move to different area

of the diagram. You can also press the [Alt] key to use the pan tool.

Pin states are shown in different colors:

m  Black — No connect

m  White — Disabled

m  Green — Enabled

m  Grey — Power/ground pins

m  Orange — Fixed function pins

m  Red - Error state

m  Semi-transparent — The hardware resource’s enabled state has been locked.
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PSoC 6 Applications

Peripherals Pins Anslog-Routing System Peripheral-Clocks DMA
Enter filter text,., & |\EK dEa@E aq 5:
Resource Mame(s) Personality ~ 13 12 11 10 9 8 7 6 5 4 3 2 1
¥ Port®
[+ poro CVBSP_WCO_IN Pin-11 v veoica) | vooh 2o v (woo) | A
PO[1] CVBSP_WCO_OUT Pin-11 v B @ : N B
[T ez ioss_0_port_0_pin_2
[T po3 ss_0_port_0_pin_3 & @ = veoro) | s sl | C
[1 Py ioss_0_port_0_pin_4 ) (ree) (o) (B B ) =) @ D
I:‘ PO[3] ioss ort 0_pin 5
v Portl 37 | (Pa) | | Pag ) | E
[~ P10 CYBSP_CSD_TX Pin-1.1 w - ) (P o F
D P1[1] ioss_0_port_1_pin_1 ] !
e =) @) ) |6
(EE) )_port_1_pin_3 - . « | H
[P ort_1_pin_4
[ es) ) port_1_pin_5 @ wa A
Vv Port2 @ {moml) (74 (VS vss | bea) vmoz) (e ) | K
I:‘ P2[0] ioss 0 port 2 pin 0
Oean  [omtporopnd @@~ POOS @@L
DPE[E] ioss_0_port_2_pin_2 PA[S] LoK) PS[S] P52] | | Py p26] | | P2L3) 2] | hemess) | M
[ ram ioss_0_port_2_pin_3
- el ) ((Psian) [ P Pa) | (72 ) (Pzs)) | N
D P2[4] ioss_0_port_2_pin_4
L] pais] ss.0port 2 pin_5 CY8C6247BZ1-D54 (124-BGA)
I:l P2[6] ioss_0_port_2_pin_6 Assigned Pover ® Eror
P2[7] CYBSP_WIFI_HOST_WAKE [Pin-11 ® Dedicated  GPIO
S Pog3 v
Bluetooth Applications
Resource Mame(s) Personality .
» Peripherals
v Pins  [ioss 0 Pins-10
PO |ETN_USER Pin-10 v
[Pt fics
[Tez |i
[Tez i
[ea
[+ s Pin-10 v 2 s e 5
[1e6 fios & | VDD 3%
[ ra |iesso B ==
I:‘Pg & P15
CYBT-213043-02 (35-SMT)
P10|PUART CTS Pin-10 v R
P11|PUART_RTS Pin-10 v EO
D p12i 11 | P37
12 P
ez
3 R 31
e 3
14 A
P15
|:| 15 P10
ez g
[1e2s
pz7 Pin-10 v
[ paa|ics 2 n - o on
BEF &L &R R EIRE
[ p29iass_0_pin_29 . -
[ p32|pusRT TX Pin-10 = Bl LR il N
P37|PUART RX Pin-10 v pesigned Pover @ Error
@ Dedicated GO
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Analog-Routing Tab

The Analog-Routing tab shows the various analog resources in your application. Enabled resources are green.

Peripherals Pins Analog-Routing System Peripheral-Clocks
LK
]
]
CUR
B
amsbizs
: amatc
o g crm
L cne
t vre et
LU
e
P o404
CEEEEEEE E

L £ R

LR

0]
il

samancn

veun

i
gt

g

There are zoom commands to resize the diagram as needed. The Edit 7 command opens the Analog Route

Editor.

Analog Route Editor

The Analog Route Editor allows you to manually edit the routing of analog resources in your application. It also

provides the ability to lock-down all or some of the results.

'Y
SEnsE
e,
ot
P s e i
LA chiby
el et
-
99999
49400 $
EEEEEEE

B

|
i

s
s

ter text... [
MNets
(:} amuxtd_bb_s|
(:} amuxtd_bb_sr
O ioss0_port8_p8_p36
= (5D (CapSense, etc.) 0 amuxbus_b, PB[7] analog
B CSD (CapSense, etc.) 0 amuxbus b
- P2[7] analog
(:} amuxtd_bb_s|
(:} amuxtd_bb_sr
O ioss0_port8_p8_p37
= P10[0] analog, 12-bit SAR ADC vplus
= P10[0] analog
= 12-bit SAR ADC vplus
(:} pass0_sarmuz_swi
= P10[1] analog, 12-bit SAR ADC vplus
- P10[1] analeg
BB 12-bit SAR ADC vplus
O pass0_sarmuxd_sw1

Switch Legend
Open
O Open (edit mode)
O Closed and unlocked
. Closed and unlocked (selected)
. Closed and locked
. Closed and locked (selected)
Closed and locked (by a different net)

= [

Locked | =

Note If there are configuration errors, complete routing results will not be available; only locked resources. If you
open the Analog Editor in this error state, a warning message will display. You can still lock and unlock switches,

but you won'’t get complete routing results as long as the configuration has errors.
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Select a Resource

To select an analog resource, click on it. Any enabled (green) element in the tree can be selected. The resource
and the associated route(s) become blue. Also, the Edit Route command appears on the toolbar. See Edit Route.

aﬁ |
amuxt4_aa_sr]

=

At the same time, the selected analog resource(s) is highlighted in the Nets tree.

Enter filter text...

MNets
Q amuxtd_bb_s|
{:} amuxtd_bb_sr
0 ioss_portd_pd p56

* (5D (Cap5ense, etc.) 0 amuxbus_b, P8[7] analog
- 5D (CapSense, etc.) 0 amuxbus_b

B P3[7] analeg
{:} amuxtd_bb_s|
O amuxtd_bb_sr
0 ioss0_portd_pd p57
* P10[0] analog, 12-bit SAR ADC vplus
= P10[0] analog
- 12-bit SAR ADC wplus
{:} passl_sarmuxd_sw0
= P10[1] analeg, 12-bit SAR ADC vplus
= P10[1] analog
- 12-bit SAR ADC vplus
Q passl_sarmued_swi

1
Switch Legend

Open
™~ PR

& | E
Locked | =

WWwWWw.Cypress.com
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You can also select items in the tree to highlight them in the diagram.

filter text
er iExt.,

- =

Enter

rup)

Mets Locked [*
{:} amuxtd_bh_sl
{:} amuxtd_bb_sr
{:} ioss0_portd pd p536
= (5D (Cap5ense, etc.) 0 amuxbus_b, P8[7] analog
= 5D (CapSense, etc) 0 amuxbus_b
- P3[7] analeg
{:} amuxtd_bb_sl
& | {:} amuxtd_bb_sr
L == : O ioss0_portd_p8_p57

= P10[0] analog, 12-bit SAR ADC vplus
P10[0] analog*
BB 12-bit SAR ADC vplus

o pass_sarmuxl_swl

~ P10[1] analog, 12-bit SAR ADC vplus
== P10[1] analog
- 12-bit SAR ADC vplus

. {:} pass_sarmuxl_sw
WS 4 »
wplis
Switch Legend
Open

Edit Route

With an editable analog resource selected, click the Edit Route command to enable edit mode. If multiple routes
are selected, a pull-down menu displays to select the route to edit. You cannot edit multiple routes at the same
time.

In edit mode, the net tree shows only the applicable route entries, and you cannot select resources using the tree.
However, the lock/unlock check boxes remain enabled for use. The inactive switches change color to indicate
they can be selected to use for the route being edited.

Route changes are live with updates applied automatically as you make changes. Selecting a switch adds it to the
current route in a locked state and the route tree is updated to reflect the modifications.

If a change results in an error, a message displays. The routes are automatically rolled back to the previous state,
so you will lose at most the last invalid change.

The toolbar shows the Finish edit command to return the editor to selection mode.

Note If a route is edited so that it uses switches associated with a location where no personalities are instantiated,
you must manually power on the containing block at startup in order for the switches to function. Refer to the PDL
API Reference Guide and the Device Technical Reference Manual for more details.
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System Tab

The System tab provides access to system-level items, such as system clocks, power management, and debug
interfaces. All available resources are shown in an expandable tree. The filter box and the hide disabled button
above the list of resources allows you to limit the items shown in the tree. This tab allows you to enter one or more
Names for the resource, and it shows the selected Personality.

» Miscellaneous

LY

Peripherals  Pins  Analog-Routing  System | Peripheral-Clocks ~ DMA
Enter filter text... T B X B E
Resource Name(s) Personality
Debug cpuss_0_dap_0
Power srss_0_power 0
¥ |V System Clocks srss_0_clock 0 SysClocks-1.2 g
v FLL+PLL e
v FLL srs5_0_clock_0_fIl_0 FLL-20 - e = 1 cLk_paTHo
(&1 PATH_MUXO0|srss_0_clock_0_pathmux_0| PAT X - '\ . J
- ; CLK_ALT_
@ PATH_MUX1 |srss_0_clock_0_pathmux_1| PATH 1 SYS_TICK
- |
(@ PATH_MUX2|srss_0_clock 0_pathmux_2 g PLLO 8Miz 1%
) PATH_MUX3|srss 0_clock 0_pathmux 3 £ DL J CLK PATHI | CLE HFL
- ’_1 100 M +2.4%
@ PATH_MUX4 srss_0_clock 0_pathmux_4| PATH -
@ PATH_MUXS srss_0_clock_0_pathmux_5| PA 3 S
V| PLLO srss_0_clock_0_pll_0 PLL-2.0 > = - )
v PLLY srss_0_clock 0_pll_1 PLL-20 - <
~ High Frequency ’_é CLK PATH3 | CLK_HF4 |
V| CLK_FAST  |srss_0_clock_0_fastclk_0 ? ’—1 100 Mz +2.4%
V| CLK HFO  |srss_0_clock 0_hfclk 0
= 100 1z 2 2.4%
v CLK_HF1 srss_0_clock_O_hfclk_1 '_E CLK PATH4 A\ | T
V| CLK HF2  |srss_0_clock 0_hfclk 2 = _
100 e 42.4%
V| CLK_HF3 srss_0_clock 0_hfclk_3 )
v CLK_HF4 srss_0_clock_O_hfclk_4 l—‘,_§ CLK_PATHS |
V| CLK_HF5 srss_0_clock_0_hfclk_5 =
V| CLK_PERI 0, kO k0 ELELF
srss_0_clock_0_peric
y — €
/| CLK_SLOW  |srss_0_clock_0_slowclk 0 | CLK_SLOW-1.0
» Input

The interactive clock diagram shows all the system clocks and how they connect to each other. You can
enable/disable a clock by double-clicking it in the diagram. Enabled clocks are green, disabled clocks are white,

and clocks in error state are red. There are also zoom commands to resize the diagram as needed.

Note The semi-transparent (faded) elements in the diagram indicate that their enabled state is locked.
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Peripheral-Clocks Tab

The Peripheral-Clocks tab lists all the clocks in a design used to drive the various peripherals. All available
clocks are shown in an expandable tree. The filter box and the hide disabled button above the list of resources
allows you to limit the items shown in the tree. This tab allows you to enter one or more Names for the resource,
and it shows the selected Personality.

Peripherals Pins Analog-Routing System Peripheral-Clocks DMA

dlvem s am

Resource

v  Bhbit
8 bit Divider 0
8 bit Divider 1
[ & bit Divider 2
8 bit Divider 3

Mame(s)

CYBSP_SDIO_DIV

CYBSP_CSD_COMM_CLK_DIV

peri_0_div_8 2

CYBSP_CSD_CLK_DIV

Personality

Peripheral Clock-1.0
Peripheral Clock-1.0

Peripheral Clock-1.0

2 bit Divider 4

Peripheral Clock-1.0

] & bit Divider 5

] & bit Divider 6

] ¢ bit Divider 7

16 bit
w165 bit

[ 16.5 bit Divider 0|peri

[ 16.5 bit Divider 1|peri

[ 16.5 bit Divider 2| peri

D 16.5 bit Divider 3 [peri_0_div

24.5 bit

DMA Tab

The DMA tab lists all the DMA resources in the design. All available DMA channels are shown in an expandable
tree. The filter box and the hide disabled button above the list of resources allows you to limit the items shown in

the tree. This tab allows you to enter one or more Names for the resource, and it shows the selected Personality.

~  DMA DataWire 0

Peripherals Pins Anzlog-Routing System Peripheral-Clocks DMA
|E>, G|YBE® 4
Resource Mame(s) Personality

DMA DataWire 0: Channel 0 | cpuss_ 0

dwl_0_chan_0 | DMA-1.0

DMA DataWire 0: Channel 1 | cpuss_ 0

dwl_0_chan_1 | DMA-1.0

I:‘ DMA DataWire 0: Channel 2

dwl_0_chan_2

I:‘ DMA DataWire 0: Channel 3

dwl_0_chan_3

I:‘ DMA DataWire 0: Channel 4

dwl_0_chan_4

I:‘ DMA DataWire 0: Channel 5 | cpuss_ 0

dwl_0_chan_5

I:‘ DMA DataWire 0: Channel 6 | cpuss_0

dwl_0_chan_6

I:‘ DMA DataWire 0: Channel 7

dwl_0_chan_7

I:‘ DMA DataWire 0: Channel 8

dwl_0_chan_8

I:‘ DMA DataWire 0: Channel 9

dwl_0_chan_9

[] pmMa Datawire 0: Channel 10|cp

dwl_0_chan_10

[] pmMa Datawire 0: Channel 11| cpuss_D

dwl_0_chan_11

[] pmMa Datawire 0: Channel 12|cp

dwl_0_chan_12

[] oma Datawire 0: Channel 13

dwl_0_chan_13

[] pmMa Datawire 0: Channel 14|cp

dwl_0_chan_14

I:‘ DMA DataWire 0: Channel 15| cpuss_0_

dwl_0_chan_153

DA DataWire 1
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Panes

The Device Configurator tool contains the following primary panes that display information based on what is
selected in a particular resource tab:

m Parameters — This pane shows the various parameters for any specific resource enabled in one of the
tabs.

m Notice List — This pane shows any errors, warnings, tasks, and infos for the application.

m  Code Preview — This pane shows a preview of the code that will be generated for the selected resource
when you save the *modus file.

Parameters Pane

The Parameters pane contains all the parameters for a selected, enabled resource. This pane will show different
parameters for each resource, grouped by various categories. For example, the parameters for the TCPWM
peripheral are completely different than those for a pin resource. The filter box above the list of parameters allows
you to limit the items shown in the pane. Some resources also provide a link to launch a separate configurator.

TCPWM[D] 32-bit Counter 1 - Parameters (EES]
Enter filter text... & | =
Mame Value
* Peripheral Documentation
(7) Configuration Help | Open Timer - Counter (TCPWM) Documentation
~* General
f’ Clock Prescaler Divide by 1 b
Counter Resolution | (%) 32-bits
Run Made Continuous v
(7) Count Direction Up -
7)) Period 32768
7)) Compare or Capture | Capture -
* Capture
(7) Capture Input Disabled -
* |nterrupts
(7) Interrupt Source None -
* |nputs
] Clock Signal <unassigned= -
? Count Input Disabled b
7)) Stop Input Disabled -
(7) Reload Input Disabled -
(7) Start Input Disabled -
* Qutputs
(7) Overflow <unassigned:
(7) Underflow <unassigned>
?’ Capture (cc_match) | <unassigned>
~ Advanced
1.7} Store Config in Flash| v

Configuration Help

Nearly all resources provide a link to open the Peripheral Driver Library (PDL) documentation to the specific
driver. This is the Doxygen-generated HTML file located in the installation directory. To see links to the
documentation, simply highlight a resource; you do not need to enable it.
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Parameter Descriptions

As described under Icons, all parameters have a tooltip icon @ to indicate there is information about the
parameter. Hover the mouse cursor over the icon to display a description of the parameter.

Parameter Values
Different parameter types have different ways to specify a value, as follows:

m  Pull-down Menu - For parameters with a specific set of values, use the pull-down menu to select the
appropriate value.

m Selection Box — For parameters with a variable set of values, click the ellipsis [...] button to open a
selection box. There, use the check boxes to select one or more appropriate values for the parameter.
Note After selecting these parameter types, use the Go To & button to jump to the selected resource.

m  Check Box — For parameters with a true or false value, use the check box to enable or disable the
parameter.

m Text Box — For parameters with editable values, type the value in the text box.

Note Values preceded by '0' are interpreted as octal; values preceded by ‘0Ox’, ‘0X’, and ‘# are interpreted
as hexadecimal.

Signal Select Indicators

For parameters where you select a signal, there is a pull-down menu for single-select signals and a button to
open a dialog for multi-select signals.

(7) Sensell]
(2) sensel2]
(2) Sense[3]
(7) Sense[d]

(Z) Sense[5]

P1[0] analog (Buttand_Tx) [USED] -
@ 12-bit SAR ADC vmminus -
@ 12-bit SAR ADC vplus

O 12-bit Continuous Time DAC ctdrefdrive

O 12-bit Continuous Time DAC ctdvout

O AREF wbgr

O C3D (CapSense, etc) cinta (CapSense) [USED]

SEEEE

The signals have guidance icons next to them to indicate the status of the signal, as follows:
m  Green — preferred
m  Yellow — valid
m  Red - constrained

After selecting one or more signals, use the Go To & button to jump to the selected signal or open a dialog to
select from multiple signals.

Launch Other Configurators

For peripherals with their own configuration tools (CapSense, SegLCD, etc.), the Device Configurator provides
links to launch those separate configurators. After enabling the peripheral on the Peripherals Tab, the Parameters
pane contains a <Configurator> parameter, where <Configurator> is the name of the other configurator.

4 External tools

? CapSense Configurator |Launch CapSense Configuratar |

7 Caplense Tuner |Launch CapSense Tunet |

Click on [Launch < Configurator > .. .] to launch the configurator.

Note When launching another configurator from the Device Configurator, it passes information, such as the
location of the *.modus file and any configuration data, to that other configurator. Those other configurators can
be launched independently from the Device Configurator. When launched independently, you will need to either
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open or create the appropriate configuration file for that tool. If you want to use the configuration tools
independently for the same application, make sure to save the source files in the correct “GeneratedSource”
folder for the appropriate application.

Notice List

The Notice List pane combines notices (errors, warnings, tasks, and infos) from many places in your design into
a centralized list. If a notice shows a location, you can double-click the entry to navigate to the error or warning.

Motice List g X

021 Errors 1 0 wWarnings U 1Task oo Infos

Fix Description

Location

The 'Clock Signal' parameter must not be empty. CYBC6247BZ1-D54: TCPWMID] 32-bit Counter & [Clock Signal]

| =]

0 "\. ¥ | The personality '|p_assist_wifi-1.0', instantiated at 'wifi{0].power[0], is not available in any selected library. CYW4343WKUBG: Wi-Fi

(%) a\‘ ¥ | The personality 'lp_assist_bt-1.0', instantiated at 'bt[0].power[0], is not available in any selected library, CYW4343WKUBG: BT

[ ] The Low Frequency Clock Source (typically ILO) should be enabled CYBC6247BZ1-D34: LCD Direct Drive 0

A v The (1K HED clnck is nnt enahled CYACARIATRTI-NSA: TSN {(CanSense etc )l L7
Ready

Notices display in rows. Use the filters above the notices to show or hide different types of notices, as follows:

m  Errors — These indicate there is at least one problem that must be addressed before you can build your
application. Typical errors could include compiler build errors and connectivity errors.

m  Warnings — These report unusual conditions that might indicate a problem, although you can usually
build the application regardless.

m Tasks — These are actions you need to perform to resolve an issue, such as enabling a resource. If you
save without resolving a task, it becomes an error.

m Infos — These are informational messages from the system to indicate something occurred.

The Notice List pane contains the following columns (each column header contains an arrow control to change
the sorting of the notices in the table):

m lcon - Displays the icons for the error, warning, task, or info.
m  Fix — This may display a wrench icon, which can be used to automatically address the required notice.

Description — Displays a brief description of the notice.

m Location — Displays the specific line number or other location of the message, when applicable.

Fix a Task/Error

When a wrench h\-“ icon displays in the Fix column, click on it and select the appropriate action from the pull-
down menu. When all related issues have been addressed, the notice will be removed from the Notice List pane.

a\‘ Black TCPWHA[L] 16-bit Counter 22* must be enabled for ‘teparn
patt of a net.

Enable Timer - Counter' at TCPYWHRA[1] 16-bit Counter 22"
Enable 'PWHA" at TCPWHA[L] 16-bit Counter 22
Enable "Quadrature Decoder' at "TCPWHA[L] 16-hit Counter 22"

Note The fixes listed are not necessarily the only way to fix the issue. They are merely common options. Also, if
you save the *modus file with outstanding tasks, they become errors saved in the
GeneratedSource/cycfg_notices.h file.

Copy a Notice

You can copy a notice to your system’s clipboard using [Ctrl]+[c] or right-click and select Copy. Then, paste the
notice text into an email, document, and so on.
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Code Preview Pane

The Code Preview pane is a read-only preview of the code that will be generated for the currently selected
resource when you save the *.modus file. As you update configuration options, the Code Preview pane updates

the code shown. This code will be written to the appropriate file(s) located in the GeneratedSource folder of your

application.

Code Preview E=
hal

/% NOTE: This is a preview only. It combines elements of the .c and .h files. %/ =

#include "cy_smif.h"

#¢include "cycig gspi_memslot.h”

#1if defined (CY_USING_HAL)
¢#include "cyhal hwmgr.h™

#endif //defined (CY_USING_HAL)

#define smif 0_HW SMIFO

#define smif 0 TRQ smif interrupt IROn

#define smif 0_MEMORY MODE ALIGMENT ERROR (0UL)
$define smif 0 _R¥ DATA FIFO UNDERFI]
#define smif 0_TX COMMLND FIFO OVER
#define smif 0_TX DATA FIFD OVERFLQ Select All
#define smif 0_RX FIFQ TRIGEER LEVE

Copy

#define smif 0 TE FIFO TRIGEER Levg  Find Ctrl+F
¢define smif 0 _DATALINESO 1 (IUL) . Find next 3
¢define smif 0 _DATALINES2 3 (OUL) _ _ _
gdefine smif O DATALINES4 5 (OUL) Find previous Shift+F3

#define smif 0 DATRLINESE 7 (0UL)
#define smif 0_550 (1UL)

g#define smif 0_S5S51 (OUL)

#define smif 0 332 (0UL) b
4

Quad Serial Memory Interface (QSPI) 0 - Parameters | Code Preview

You can select and copy code from this pane using [Ctrl]+[C] key or using the right-click menu option.

You can use the Search feature to find instances of specific terms.

References
Refer to the following documents for more information, as needed:

m  Eclipse IDE for ModusToolbox User Guide

m  ModusToolbox User Guide

m APl Reference Guides
m  Device Datasheets

m  Device Technical Reference Manuals

Version Changes

This section lists and describes the changes for each version of this tool.

Version Change Descriptions Notes
1.0 New tool.
11 Added support for WICED Bluetooth devices.
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Version Change Descriptions Notes
2.0 Changed the Platform tab to System tab. This affects the file name generated during code

generation. Older versions of the Device Configurator
generated cycfg_platform.(c/h) files; it now generates
cycfg_system.(c/h) files. If you are updating a design
from a previous version, manually remove the old
cycfg_platform.(c/h) files and update any references
you created to use the new file names.

Moved the Analog-Routing Editor to a tab.

Updated the File menu for library settings.

Added Update All Personalities menu item.

Added the ability to enter multiple resource Names using
comma-separated list.

21 Added Open System Explorer menu item.

Added Change Devices menu item and dialog.
Added Undo/Redo operations to the Edit menu.
Added major/minor version number to the title bar.

2.20 Added Copy feature to the Notice List.

Added ability to see documentation links without enabling
a resource.

Added frequencies to clock diagram.
Added feature to support incremental patch updates.

221 Added Search feature to Code Preview.

Implemented various performance improvements.
Fixed an issue with multiple font sizes in the GUI.
Fixed the PDL display name when using the MTB flow.

Updated to allow analog routing from the SAR to any
analog resource or pin.
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